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1. LEGEND CONTROL PANEL 

 

The Legend Control Panel is where you’ll be able to configure / setup most of the aspects of your system. Most 
of which is covered in this guide.  
 

 
 

1.1. ADD NEW WORKSTATION 

 

 Open Legend Control Panel >> File (Menu) >> New >> New Workstation. 

 Enter the workstation name in the “NetBIOS Name” field. 

 Enter a friendly name for the workstation in the description. E.G – Managers PC. 

 Click the Next button until you’re asked to pick a location and then select the primary location that you 
intend to use this workstation at. 

 At the end of the wizard check the box to “Create and activate a register for this workstation”. 

 The workstation will now have permission to logon to the Legend desktop. 
 

1.2. GLOBAL / REGION / CLUB SETTINGS 

 

If you’re unsure about anything in these settings, please contact our support team for guidance. We strongly 
recommend not changing anything unless you’re confident you know the effect it will have on the system. 
 
As we continue to add new features you’ll find instructions on how to enable & configure these in our release 
notes. 
  



2. COST CENTRES & GENERAL LEDGER CONFIGURATION 

2.1.  COST CENTRES  

 
A cost centre is a grouping of general ledger codes used for accounting purposes. Typically each department 
within an organisation would have a different cost centre. For example-  Swimming, Camps, POS etc. 
 
Add/Edit Cost Centre: Open Legend Control Panel >> Data tab >> Cost Centres. 
 

 New: After clicking this button enter the short and full descriptions, both of these are internal 
descriptions and will appear on financial reports. Ignore any prompts that appear asking for a reason for 
change, this is not logged anywhere. 

 Edit: Select the cost centre you want to edit and then enter the number for this cost centre, this will 
appear on financial reports. 
 

 
 

2.2. GENERAL LEDGER 

 
Add/Edit General Ledger: Open Legend Control Panel >> Data tab >> Cost Centres >> Edit >> Accounts tab. 
 
If you select ‘Add’ first, you’ll be prompted to enter descriptions before you can do anything else. Once you’ve 
done this you can proceed to edit the GL. 

 
When you select ‘Edit’ you’ll have the following fields / options. 
 

 Short Description / Full Description / On-line Description: These should all be exactly the same for 
consistency, they will only be used internally for reporting purposes. 

 Account Category: Used to define where this GL Account can be used.  
o POS: Can be used for the majority of GL’s. 
o Bookings: Used for booking related GL’s. 
o Membership Charges: Allows the GL to be used for manually raised charges. 



o Payments: Allows the GL to be used for manually clearing / writing off outstanding charges / 
payments. 

 Account Label: This is where you enter the GL Account code, in the example below you can see I have 
set the GL to report to code 4001. 

 Subcode – Not used. 

 Security token: Not used. 

 Invoice Nominal Code: If you use Legend Invoice Management then you can link your pre-existing 
Nominal codes from the invoicing system to the GL Account within Legend. 

 Active / Inactive Date: Used to phase out / in the ability to use this GL account. 

 Inventory Used For Tax Rate (Manual Charge): When raising manual charges in Membership 
Management, this GL can be linked to an inventory item that has a specific tax code. For example, you 
might want raise a charge for a child camp that is tax exempt, the inventory item controls this. 
 

 
 
Advanced documentation for cost centres and GL accounts is available at www.legendreleases.co.uk  
  

http://www.legendreleases.co.uk/


3. INVENTORY MANAGEMENT 

 

Inventory items are used across the whole of the Legend system, they’re attached to POS sales, Courses, 
Programs, Rentals etc. They can be setup on a global, region or club (facility) level. If an inventory item is set at a 
region or club level, it will be restricted and will only allowed to be used in those regions and/or clubs. 
 
In most cases it’s best practice to create all of the inventory items at the global level to avoid duplication of 
items and to be able to report on sales with more efficiency. 
 
Please note: You should never rename / reuse an inventory item that has previously been sold.  

 To access this module: Open Legend Control Panel >> Inventory Management. 
 

 
 

 Inventory Hierarchy: On the left you’ll see the inventory hierarchy of Global, Regions and Clubs 
(Facilities). The best practice is to setup all new inventory items at the global level and manage them 
centrally. 

o Global: Inventory item is available to be used at any region or club. 
o Regions: Inventory item is only available to be used at the clubs within the selected region. 
o Clubs: Inventory item is only available to be used at the selected club. 

 Show Inactive Items: At the top left you have a check box to show Inactive Items. 
o In most cases inventory items aren’t deleted, they’re made inactive. 
o Check this box to include any inventory items that have previously been made inactive. 

 Inventory Filter: At the bottom right you’ll see a text box where you can enter your search criteria to 
narrow down the inventory list to what you want to find. 

  



3.1. ADD / EDIT INVENTORY ITEM 

 

 Open Legend Control Panel >> Inventory Management >> New. 
 

 
 

 Inventory Item:  The text entered here will appear in the basket and on the receipt. 

 Description: Best practice would be to use the same as the inventory item name. 

 Category: This is mainly used for reporting on the use / sale of inventory.   

 Subcategory: As above.  

 General Ledger: Select the default GL account that you would like to attach to this inventory. 

 Item Type: This defines where the inventory will appear and can be used. 
o POS: Is typically used for any items you would sell through Front of House or online as an extra 

or part of a bundle. 
o Booking: Is used for classes, programs, courses, rentals etc. 
o Voucher: You must setup a voucher inventory to link to a voucher, this is covered later in the 

guide but the inventory needs to be created to determine the price. 
o Service: Only inventory with the type of Service can be attached to contact services, these are 

covered in detail later in this guide. 
o Online Ticket: Only inventory with this item type can be used when configuring tickets in the 

back office website. 
o Camp: Only inventory of this type can be used when configuring camps in the back office 

website. 
o Camp Extra: Only inventory of this type can be used as a camp extra when configuring camps in 

the back office website. 
o Membership Fee: Optionally used as part of the configuration when creating new agreements.  

 Patronage Category: The category is used to group the type of item for reporting purposes. 

 Patronage Value: This is the value you would like to record when a customer purchases / uses this 
inventory item. For example, if the item was ‘Badminton’ you’d typically set the number to 3 as this is 
the average number of people you’d expect to attend this activity. 

 
Once you’ve created the inventory, find it on the list and double click on it or select it and click ‘edit’. You’ll now 
be able to complete the full configuration. Each tab of the inventory is detailed below. 
 



3.1.1. GENERAL 
 

 Additional General Ledger: For certain Item Types you can add additional GL accounts so split 
percentages or fixed amounts between two or more GL’s. 

 Wholesale Price: Can be used to add the suppliers price, not used for the actual selling price. 

 Barcodes: If this is a POS item you can enter it’s barcode here, when scanned in FOH it will automatically 
add this inventory to the basket. 

 Requires Member: This is used for POS items to only allow the purchase of this item if there is a contact 
in the member passport in FOH. 

 Is Block Booking Item: This should be checked for block booking / ad-hoc inventory items in order to 
enable the manual recording of attendance within the Legend Bookings module. 

 Supports Additional Printer: This is used if you want the till receipt to print to 2 different receipt 
printers, this is often used for café inventory items where the kitchen also requires a receipt. 

 Disallow On Account Transactions: Some memberships might allow customers to purchase items and 
pay for them later by adding the debt onto their account, if this option is selected it will disable the 
option for this inventory item. 

 Capture Notes: This will request the user to enter notes when selling the POS item through FOH. You 
can also force the note format using RegEx (regular expressions). These notes are reportable. 

 
Several options are not included in this list because they’re no longer used. 

3.1.2. AVAILABILITY 
 

 Scope: This is normally set to All Clubs (Global Inventory), if you want the inventory item to be created 
at region or club level you can select it here. It is worth noting that if you set the inventory item to All 
Clubs then you can still set individual prices per region or club / facility, this is covered in the next 
section. 

 Date Scope: - Active and Inactive dates for the inventory can be set, this will be used to set a date when 
an inventory may not be sold anymore.  If you wish to make an inventory item active again just delete 
the date in the inactive field. 

 Age And Gender Restrictions: Here you can restrict the sale of this item based upon age and/or gender. 

3.1.3. PRICING 
 

 Inventory Price Hierarchy: 
o Enterprise: Setting a price at this level will be the selling price of this item unless overridden. 
o Regions: Setting a price at this level will override anything set at enterprise. 
o Clubs: Setting a price at this level will override anything set at region or enterprise. 

 Ask For Selling Price: This option can be selected for POS item type inventory. When selling this item 
through FOH it will prompt for the user to enter the price. 

 New / Edit: Will allow you to add or edit a price. 
o General > Selling Price: Enter the selling price. 
o Availability > Scope: Set the scope of the inventory price as per the inventory price hierarchy. 
o Availability > Date Scope: You can create multiple prices with different active / inactive dates, 

this is the easiest way to manage price rises for individual inventory items. 
o Availability > Selling Period: You can define the selling period of this price. For example, at Peak 

time it might be one price and Off-Peak another.  
 



3.1.4. TAX 
 

 Every inventory item will use the default tax code that has been configured for each club / facility. 

 If required these can be overridden in the ‘Override Code’ drop down.  

 You’ll need to click the ‘Save’ button and then ‘Apply’ to save your changes. 
 
Please refer to our Sales Tax Manager documentation for the configuration of Tax Profiles.  

3.1.5. OPTIONAL DISCOUNT 
 
Optional discounts are manually applied in the Front of House application. When you add this inventory item to 
your basket > Select ‘Options’ in your basket > Select ‘Discount’ > You’ll see any optional discounts setup for this 
inventory item, clicking on them applies them to the selected inventory. 
 

 General > Discount Type: Select the discount type you wish to be optionally available (discount types 
are covered later in this guide). 

 Availability > Scope: Sets the level as to which this discount will be available for use. 

 Availability > Date Scope: Enter active / inactive dates for this discount to be available. 

 Availability > Selling Period: Allows you to define periods that this discount will be available for use. 

 Availability > Age Based Discount: Allows you to restrict the discount for an age range. 

 Availability > Discount Application Scope: 
o Discount Source: Agreement based or Service based. 
o Agreement Type: If you select the source as ‘Agreement’, it will allow you to pick the agreement 

type that the discount will apply to. Leaving this set to <All> will set the discount to be available 
to all agreements but will still take into account any other settings configured on the availability 
tab. 

o Agreement Price: If you select the source as ‘Agreement’ and select an ‘Agreement Type’ it will 
allow you to pick the agreement price type that the discount will apply to. Leaving this set to 
<All> will make the discount available to all agreements for the selected agreement type but will 
still take into account any other settings configured on the availability tab. 

o Service: If you select the source as ‘Service’, it will allow you to select the service that this 
discount is available for. 

 

3.1.6. AUTOMATIC DISCOUNT 
 

Automatic discounts are applied automatically in Front of House and online depending on the discount criteria 
that is setup in this area. 
 

 General > Discount Type: Select the discount type you wish to be automatically applied (discount types 
are covered later in this guide). 

 Availability > Scope: Sets the level as to which this discount will be applied. 

 Availability > Date Scope: Enter active / inactive dates for this discount to be available. 

 Availability > Selling Period: Allows you to define periods that this discount will be available for use. 

 Availability > Age Based Discount: Allows you to restrict the discount for an age range. 

 Availability > Discount Application Scope: 
o Discount Source: Agreement based or Service based. 
o Agreement Type: If you select the source as ‘Agreement’, it will allow you to pick the agreement 

type that the discount will apply to. Leaving this set to <All> will set the discount to be applied to 



all agreements but will still take into account any other settings configured on the availability 
tab. 

o Agreement Price: If you select the source as ‘Agreement’ and select an ‘Agreement Type’ it will 
allow you to pick the agreement price type that the discount will apply to. Leaving this set to 
<All> will make the discount available to all agreements for the selected agreement type but will 
still take into account any other settings configured on the availability tab. 

o Service: If you select the source as ‘Service’, it will allow you to select the service that this 
discount is available for. 

3.1.7. PATRONAGE 
 

 Patronage Category: The category is used to group the type of item for reporting purposes. 

 Patronage Value: This is the value you would like to record when a customer purchases / uses this 
inventory item. For example, if the item was ‘Badminton’ you’d typically set the number to 3 as this is 
the average number of people you’d expect to attend this activity. 

3.1.8. STOCK CONTROL 
 

This tab enables you to indicate which inventory items are to be monitored, for those you wish to monitor, you 
should tick enable stock control and decrement stock. 

3.1.9. ACCESS CONTROL MANAGEMENT 
 

There are 2 parts to the ACM tab.  The fast access options are for kiosks. It is important to select the receipt type 
as this will be what is printed out by the kiosk when the item is selected / purchased via the kiosk.  Kiosk text will 
allow a site to put some text on the receipt that prints out of the kiosk.  There is also an option to set a 
maximum amount of usages in one day for a certain inventory item. 
 

3.2. COPY INVENTORY 

 

 The fastest way to setup a new inventory is to first find an item that is setup similarly to the new item 
you want to create.  

 Open the inventory item and select the ‘Copy’ button (located to the bottom left of the General tab). 

 You’ll receive a popup notifying you that it’s been copied. Click the X or Cancel button to return to the 
inventory list. 

 Search for ‘Copy of’ and you’ll see your new inventory item that you can now edit.  
 

Please note: This will copy everything including pricing and discounts. 
  



4. ADDITIONAL INVENTORY CONFIGURATION 

4.1. INVENTORY CATEGORIES 

 

Main and Sub Categories are required when configuring inventory items. 
 
Add/Edit Main Category: Open Legend Control Panel >> Data tab >> Inventory/POS > Main Category (reporting). 

 Short Description: Enter a short description for the category. 

 Description: Enter the full description for the category. 

 Display Order: Set to 0. 

 GL Account: This should always be set to n/a. This GL is not used anywhere in Legend. 
  
Add/Edit Sub Category: Open Legend Control Panel >> Data tab >> Inventory/POS > Sub Category (reporting). 

 Name: Enter the name of the category. 

 Description: Enter the full description of the category. 

 Main Category: Select the main category that this is relates to. 

 GL Account: This should always be set to n/a. This GL is not used anywhere in Legend. 

4.2. SELLING PERIODS 

 

Selling periods are used to define the days / times that different rates of prices apply. 
 
Add/Edit Selling Period: Open Legend Control Panel >> Data tab >> Inventory/POS >> Configure Selling Periods. 

 Priority: Set the priority of this selling period to 1 if it’s the highest priority or 0 if it’s the lowest priority. 
If two selling periods overlap it will define which takes priority. 

 Standard Days/Times: Define your selling period here by selecting the day of the week and all day or 
specific times. 

 Specific Days/Times: Clicking ‘New’ allows you to select specific days and times for your selling period. 
 

 
 



4.3. CONFIGURE DISCOUNT TYPES 

Discount Types are most commonly attached to inventory items to provide automatic or optional discounts. 
 
Add/Edit Discount Types: Open Legend Control Panel >> Data tab >> Inventory/POS >> Configure Discount 
Types. 
 
Discounts use the standard Legend hierarchy of Global, Region or Club. These options define where the discount 
will be available for use.  
  

 Selecting New or Edit will open a window with 3 tabs. 
 

 
 

 General > Description: Enter the description of the discount.   

 General > General Ledger: Best practice is to make sure all discounts use the default 00-005-, Discount 
GL. 

 General > Apply To All Items Within Scope: This will enable the discount type to be manually applied for 
any item in FOH, regardless of if it’s been configured on the inventory item or not. 

 General > Shade Discount In POS: Should be ticked to better highlight an applied discount in FOH. 

 Discount Setup > Discount Amount: Set the percentage, exact amount or overridden price for this type. 

 Discount Setup > Discount Rounding: Set the rounding type down or up and to the closet amount.  

 Scope > Scope: Set where you want the discount to be available for use. 

 Scope > Inventory Scope: Specify the number of items required before the discount will be applied.  
For example, this could be use for 2 for 1 offers where 2 items must be added to the basket to apply this 
discount type. 

4.4. MASS ADD INVENTORY DISCOUNTS 

 
This allows a single discount to be applied against multiple inventory items, e.g. 100% discount applied to all 
classes for Gold agreements. Users will require the security token CP_BULKADDDISCOUNTS in order to access 
the feature. 
 
Mass Add: Open Legend Control Panel >> Data >> Inventory/POS >> Mass Add Inventory Discounts. 

 Please note that using this tool can create duplicate discounts – Make sure to inactivate any current 
discounts by selecting the checkbox. 
 



4.5. MASS ADD INVENTORY PRICES 

 
Mass Add: Open Legend Control Panel >> Data >> Inventory/POS >> Mass Add Inventory Prices. 
 

 Please note that using this tool can create duplicate prices – Make sure to inactivate any current price by 
selecting the checkbox and/or setting an activate date in the future. 

 

4.6. MASS CHANGE INVENTORY ITEMS 

 
Mass Change: Open Legend Control Panel >> Data >> Inventory/POS >> Mass Change Inventory Items. 
 

5. VOUCHERS 

5.1. CREATING A COUNTDOWN VOUCHER 

 

Before creating a voucher, you will need to create a new inventory item with the voucher item type, this 
inventory item cannot be linked to any existing voucher. 
 
Add/Edit Vouchers: Open Legend Control Panel >> Data tab >> Configure Vouchers. 
 
Enter in the General tab: 
 

 Name: Identify the voucher. 

 Voucher Type: Select Loyalty as these are the type that count down. 

 Sellable Qty: How many usages of this voucher the customer will receive. 

 Linked inventory: Select the inventory item you have created for this voucher to link to. The scope of 
the inventory will need to match the scope of the voucher otherwise it won’t be selectable. 

 GL Account: You can safely select ‘Generic’ here as the GL Account is reported from the inventory item 
rather than the voucher. 

 Scope: Select where you want the voucher to be available for use. 

 Validity Option: Specify the vouchers expiration. Do not select Is On Demand Voucher. 

 
 



 Applies tab: Select any categories and/or individual inventory items that this voucher will apply to. This 
will define which items they can ‘purchase’ for free by redeeming this voucher.  

 It is important to make sure that you don’t select the voucher inventory item in the applies tab, 
otherwise you’re just enabling the purchase of this voucher to purchase more vouchers. 

 

 
 

5.2. CREATING A SALES VOUCHER 

 

If you sell gift vouchers through a POS button and you want to redeem these as a payment method, you need to 
add a sales voucher. Go to Legend Control Panel > Data > Configure Vouchers. Then add new and call the 
voucher the denomination required, ie: £10 voucher. 
 
When someone now comes in with the voucher they have bought from you and you have rung through the POS 
screen as a button when you come to pay for the item go to pay > click exact > then click on the voucher 
required.  
  



6. AGREEMENT MANAGEMENT 

 

Agreement management allows you to setup your membership schemes for use within Legend. 
 
Add New Agreement Type: Open Legend Control Panel >> File >> New >> New Agreement. 
 
This is only needed if you wish to add a completely new type of membership, not just a new price type. 

 
 

 Agreement Name: This is a short description that isonly used internally. 

 Agreement Description: This is what the customer will see on their account and online. 

 Agreement Type: Should always be set to Membership. 
 

 
 
Once this has been created you can find the agreement in the Agreement Management module in Legend 
Control Panel. 
 

6.1.  GENERAL 

 

 Agreement Name: This is a short description that is only used internally. 

 Agreement Description: This is what the customer will see on their account and online. 

 Agreement Type: Should always be set to Membership. 

 Allow Passback: If using access control, you can allow members to use their access cards more than 
once within a defined period (within Club Settings). 

 Is Quick Add: Select this if you want this agreement and any price types to appear in Front of House as a 
QuickAdd agreement (Casual / PAYG). 

 Allow On Account Transactions: If selected members can pay in FOH by adding the debt to their 
account to be paid at a later date. Can be overridden per agreement price type. 



 Set On Account Limit: If you choose to allow on account transactions you can limit the amount that can 
be tendered.  

 Billing Methods: Select all available billing methods to allow when configuring the agreement price 
types. These options will not be available to customers unless you create a price type using a specific 
billing method. See the Pricing tab section for more detail.  

 Booking Advance Limit: This option only applies to Legend Class bookings, if you choose to override the 
advance limit it will ignore the limit that is set on the activity and instead use this value.  

 Force Booking Payment: If you allow book & pay later options for bookings you can select this option to 
make sure that anyone on this agreement is always prompted for payment. Most commonly used for 
casual or pay as you go QuickAdd agreements. 

 Support Online Interest Groups: See the relevant documentation for setting up this feature. 

 Display at Risk Members on this Agreement in CRM: Tick this box if you’re using or intending to use our 
CRM module. 

 Member Eligibilities: This area will show if the member will be automatically granted any eligibilities, 
these are configured within the ACM module.  

 Patronage Category: n/a 

 Default Status for Online Joiners: When a member registers onto this agreement type you can set their 
default membership status, by default it’s recommended to set as Pending. 

 Gantner Integration: See the relevant documentation for setting up this integration. 
 

 

6.2.  MEMBER ACCESS 

 

Select the days / times that a customer on this membership can access facilities. 

6.3.  INVENTORY 

 

The inventory items for each process type can be assigned here. If set at this level, they will automatically apply 
to all agreement price types that are setup under this agreement. These can be overridden on the agreement 
price type (Pricing >> Inventory tab).  



When creating inventory items for use here, the item type needs to be set to ‘Membership Fee’. 

6.4. PRICING 

 

This tab is where you define the types of membership that are available at an enterprise, region or club level. 
Selecting a specific region or club will mean that the membership is only available for sale at that specific club or 
clubs within the region. 
 

 
 

 Duplicate: After you’ve setup your first agreement price type, it’s best practice to duplicate it and edit. 

 Add/Edit: Clicking either of these will open up another window with a new set of tabs. 
 

6.4.1. GENERAL 

 

 Description: Change the price type description. 

 Payment Cycle: How often the member will be billed. 

 Default Billing Method: Pay in Full (Cash), Credit Card or Direct Debit (EFT). 

 Club Access: If your company has multiple sites you can restrict access. 

 Enterprise Wide Booking: Members on this agreement will be able to book at any club. 

 Include agreement in the “hard count”: Included in the hard count report, selected by default. 

 Is a “short term” membership price: N/A 

 Allow On Account Transactions: If selected members can pay in FOH by adding the debt to their account 
to be paid at a later date. 

 Allow Opt Out of Induction: N/A 

 Allow upgrade to change billing method: N/A 

 Enable additional upgrade fees: After configuring the Upgrade Paths tab, selecting this will look for the 
additional fees you’ve set. 

 Ignore payments for this agreement when upgrading: Will not charge any upgrade fees if selected. 



 Allow On Account Transactions: If selected members can pay in FOH by adding the debt to their account 
to be paid at a later date. Can be overridden per agreement price type. 

 Set On Account Limit: If you choose to allow on account transactions you can limit the amount that can 
be tendered.  

 Max “Linked” Members: Defines how many members you can link to this price type. 

 Max “Add-on” Members: Defines how many members you can add-on to this price type. 

 Default Status for Online Joiners: Can inherit from the head agreement or be set per price type. 
 

 
 

6.4.2. SCOPE 

 

 Scope: You can set the agreement price type to be available at all clubs, specific groups or just an 
individual club. There is an option to set the price type to become available or unavailable on a specific 
date.  

 Active/Inactive Date: These options allow you to set when the agreement is available for sale. 

 Availability: You can set the agreement price to be available in house only, online only or both. 

 Online Description: Customers will see this when browsing / purchasing this membership online, it’s 
useful to include the benefits they receive, payment terms etc. 

 Online Sales Tag: As above, appears underneath the online description. 

6.4.3. FEES 

This is where you enter the fees for this membership.  
 

 Cycle Fee: This is the main fee for the membership. E.G- If this was an annual membership you would 
enter the full amount for the term, if it’s a monthly membership enter the monthly fee. 



6.4.4. TERMS 

 

 Auto Bill: If this is selected the agreement will not lapse regardless of any last use or renewal dates, 
typically used for direct debit (EFT) or casual / pay as you go agreements. 

 Usage Months / Days: Defines the length of the agreement, for example 12 months, 0 days. 

 Billing Months / Days: Defines how often they will be billed, so if you have 12 months usage and you 
want to bill the member monthly then you would also select 12 in here, alternatively if it’s an annual 
agreement that they pay in one lump sum you would select 1. 

 Min Months In Adv: How many months payment you require up front 

 Flat Cancellation Fee: Charge the member for cancelling the agreement. 

 Percentage Cancellation Fee: Charges the member a percentage of the agreement based upon the 
usage months / days. 

 Waived Billing Days: If you have selected usage or billing days then you can waive these. 

 Renewal Months / Days: How often is the renewal of the agreement. 

 Bonus Months: Gives the member free months. 

 Use Count: N/A 

 Test Dates: Will show you how your terms relate to member agreement dates. 

 Enforceable Contract: If enabled the member cannot lapse the agreement during until the agreement 
term has been reached. 

6.4.5. PRICE CHANGES 

 
This box will show you any future and historical prices. 

6.4.6. COMMISSION 

 
You can enable the agreement to calculate points to be awarded to the user who sells this membership to a 
customer. 

6.4.7. ADD-ON 

 

 This price supports “global” add-ons as children: If enabled this would be the head agreement for an 
add-on based agreement. 

 This price is a global add-on price: If enabled this would act as the child (add-on) agreement. 

6.4.8. PRORATE 

 
If setting up a direct debit (EFT) agreement, then you can select here whether or not you want to waive any 
prorate fees. 

6.4.9. DOCUMENT 

 
At the end of the New Member Wizard and Termination Wizards within Membership Management you are 
presented with options to print documentation. Here you can select any pre-configured template documents. 
 
 



6.4.10. INVENTORY 

This works in exactly the same way as referred to on the head agreement, only it’s set on the individual price 
type instead of all agreements under the main head agreement.  

6.4.11. BOOKING RULES 
 
If you have configured booking penalties, you can select if you wish to exempt this agreement from specific 
booking types. 

6.4.12. DEMOGRAPHIC UPGRADES 
 
Setting an option at this level will apply to only this agreement price type, you can set these options to apply to 
all agreement price types on the head agreement.  
 
These options allow automation of agreement changes based upon the criteria defined below: 

 

 Agreement Change on Age Restriction Reached: This option can only be used if you have setup age 
restrictions on the ‘Restriction Rules’ tab. 

 Agreement Change on Member Lapse: This option is commonly set on paid memberships so that when 
they’re due to lapse they automatically move onto a casual / pay as you go membership. This allows 
them to continue making purchases without any previous membership benefits. 

 

6.4.13. RESTRICTION RULES 

Once configured this will allow you to restrict the purchase / upgrade onto this agreement for a specific age 
range.  
 
The rules are setup in the Legend Control Panel >> Data Tab >> Agreement >> Agreement Restriction Rules.  
 

6.5.  UPGRADES 

 
If you don’t want to restrict your membership upgrade / downgrade paths, tick the ‘Membership’ option as per 
the screenshot below. If this option isn’t selected, you won’t be able to change a customers membership. 
 

 Allow upgrades only to the following agreements: Select this if you want to specify which membership 
a customer can change onto. This effects in house (Membership Management) only. 

 Add/Edit: Select the ‘To Agreement’, this is the agreement you’re allowing this agreement to change to. 
Repeat until you’ve added all possible agreement change / upgrade paths. 

 Price: This price is an additional upgrade fee, make sure to tick all of the previous options for this to 
make sure it’s active. 



 

6.6.  ONLINE PATHS 

 
This tab allows to you specify online upgrade paths. See the previous ‘Upgrade Paths’ section for more detail.  

6.7.  DOCUMENTATION 

 
You can specify which agreement or termination documentation to relate to the wizards in Membership 
Management. There is also a box where you can write a description for this agreement that appears online 
when a member is going through the signup process. 

6.8.  RESTRICTION RULES 

 
Once configured this will allow you to restrict the purchase / upgrade onto this agreement for a specific age 
range.  
The rules are setup in the Legend Control Panel >> Data Tab >> Agreement >> Agreement Restriction Rules.  

6.9.  BOOKING RULES 

 
If you have configured booking penalties, you can select if you wish to exempt this agreement from specific 
booking types. 

6.10. DEMOGRAPHIC UPGRADES 

 
Setting at this level will apply to all agreement price types, unless overridden on the individual price type. These 
options allow automation of agreement changes based upon the criteria defined below: 



 

 Agreement Change on Age Restriction Reached: This option can only be used if you have setup age 
restrictions on the ‘Restriction Rules’ tab. 

 Agreement Change on Member Lapse: This option is commonly set on paid memberships so that when 
they’re due to lapse they automatically move onto a casual / pay as you go membership. This allows 
them to continue making purchases without any previous membership benefits. 
 

7. POS SETUP (POINT OF SALE) 

 
This module is used to create schemes of items that are available for sale through the Front of House application 
(see screenshot below). POS Schemes can be assigned on a global (enterprise), region, club or workstation level. 

 

 
 

 To access this module: Open Legend Control Panel >> POS Setup. 
 

New: This options allows you to create an empty layout or copy an existing layout.   
Edit: Select the layout from a list of previously created schemes. 
 

 
 
Both options will open up the POS Layout scheme with a number of tabs… 
 
General tab: 

 Name: Add or edit the scheme name, this name is only used internally for referring to this group of 
buttons. 

 Button Size: Allows you to set small, medium or large buttons. The smaller the button the more you can 
fit on the screen. 



 Button Font: Set’s the font for the button names. 

 Button Font Size: Set’s the font size for the buttons. 
 
Assignments tab: Shows you where this scheme is currently in use, i.e which region, workstation etc.. 
 

7.1. BUTTONS 

 

This tab is used to create the items to sell through FOH and groupings of these items. 

 

 New Group: Create as many groups as needed to make the POS items easy to find for front desk staff. 

o Multiple Groups: To create another group make sure to highlight the group that you want the 

new one to fall under. For example, if I wanted another group underneath ‘Legend Store’, I 

highlight it and select ‘New Group’.  

 

 
 

 

 New Item: Highlight the parent group that the new item will be a part of and then select ‘New Item’. If 
you don’t want the button to be part of a group, make sure nothing is highlighted before creating a new 
item. 
 

 Edit: Allows you to edit an existing group or item as per the detail below. 
 

 Delete: This is the most effective way at removing an item for sale from the POS screen in FOH. To 
delete a group, you will first need to delete all items within that group. 



 
 

 Caption: Is the name of the button, this is what will be visible in Front of House. 

 Background Colours: Each button or group can have its own colours and gradient. 

 Button Order: Is used to order the button or group. 0 the lowest and 9999 the highest. 

 Active/Inactive Date: This defines when the button or group is available to be used in FOH. 

 Button Styles: By default, they’re set to inherit the settings from the POS scheme but can be overridden. 

 Inventory Link: Click <SELECT> or the inventory name already in the box to select which inventory item 
this button links to. 

o  This button will allow you to edit the selected inventory item directly from this screen and 
will save you closing everything to go into Inventory Management. 

 

7.2. BESTSELLERS 

 
Best sellers are buttons that are frequently used by a specific club / site and appear along the bottom of the POS 
tab in FOH. 
 

 
 Open Legend Control Panel >> Club Settings >> Select Club >> Bestsellers tab. 

 



 
 

 Specify Bestsellers >> Select “Adds a bestseller”: This will open the inventory list where you can select a 
best seller to add to the POS scheme. 

 Member Control Bestsellers: When added these appear on the Member Control tab in FOH. 
 
A maximum of 16 best sellers can be selected for the home page. The order of how the buttons appear on FOH 
can be changed by highlighting an inventory and using the arrow keys to move the inventory. 
 

7.3. ASSIGN A POS SCHEME TO A REGION, CLUB OR WORKSTATION 

 
If you have multiple POS schemes this is where you can configure where each scheme is used. 
 

 Assign: Open Legend Control Panel >> Data tab >> Inventory/POS >> Assign POS Button Schemes. 

 Standard Pricing: This is the default POS scheme that will be used unless overridden at group, club or 
workstation level. 

 Pricing Groups / Clubs / Workstations: This works in the same way as the general Legend hierarchy. The 
overriding priority is Workstation > Club > Pricing Groups > Standard Pricing. 

 
Select the location/workstation to apply the scheme to >> Select the POS button Set >> Save this assignment. 
 

 



8. SUBSIDY/STORED VALUE ACCOUNTS CONFIGURATION 

 
This section will outline the configuration of subsidy AKA Stored Value Accounts. Customers will have the ability 
to configure as many subsidy accounts as required. Once assigned to a contact/member, they will have the 
ability to use subsidy values online or in Front of House as a payment method. 
 

8.1. SECURITY TOKENS 

 

Before users will be able to configure Subsidies, they will require the below security token which is located 

under the CP group. 

 

 Allow user to configure Stored Value Accounts (CP_STOREDVALUEACCOUNTS_CONFIG) 

 Allow the editing of Site Subsidies (CP_EDITSITESUBSIDIES) 

 

8.2. ACCESSING STORED VALUE ACCOUNTS MODULE 

 

Firstly, users will have to request for Legend to enable the module. An Legend engineer can enable this module 

via Control Panel > Legend Only tab > select both “Enable Configuration” and “Enable Usage” 

 

Once users access the module via Control Panel > Stored Value Accounts, they will be able to search, edit and 

create new accounts. 

 

 
  



8.3. SUBSIDY TYPES EXPLAINED 

 

Note there are two Subsidy types explained below. The option the user will select, depends on the financial 

requirement by the customer. Further, all use of subsidy values are recorded against the appropriate GL 

account. 

 

Type: 

 

 Journal on create 

o Legend records the granting of the subsidy in the accounting journal. This means that there will 

be a pot in the customer accounting system which gets larger and larger. The financial file 

exported from Legend will account for this. When customers/members use the Subsidy online 

or in Front of House, the subsidy is recorded. 

 Journal as you go 

o Legend do not record the granting of the subsidy in the accounting journal. This means on the 

financial export from Legend, this will not be recorded. When customers/members use the 

Subsidy online or in Front of House, the subsidy is recorded. 

 

 
  



8.4. SETTING UP STORED VALUE ACCOUNTS 

 

Users will need to access the module (Control Panel > Stored Value Accounts) and open the module. From here, 

select the New button which will then load the configuration screen for the new Subsidy account. Once all the 

below fields has been set, click ok to save the configuration. 

 

Configuration options/menus explained: 

 

 Type 

o Select the relevant Subsidy type required. 

 Name 

o Enter the required Subsidy account name. 

 Active From Date 

o This is from when the subsidy accounts is active from. Note, this date does not affect the dates 

for when assigning a subsidy value to a customer/member. 

 Active To Date 

o The date when this subsidy account becomes in active. 

 

Active From and Active To dates further explained (the above): 

 

If the Legend customer has a subsidy account that never expires, the Active To date can be set far into the 

future. If the configured subsidy account is annually, the Active To date can be set to the end of the current year. 

A new subsidy account will then be created every year. 

 

 Validity In 

o This specifies when the subsidy value will expire after assigning a value to a customer/member. 

Users have the option of “Months” and a “Specific Date”. 

 Validity Months/Validity Date 

o Pending on the option selected for the Validity In, users can either specify an exact date or 

number of months for the expiration of the subsidy value once assigned to a contact/member. 

 GL Codes 

There are 3 GL codes to configure: 

o Pool – where the subsidy money is sitting. 

o Holding – once a subsidy value has been assigned to a contact/member, money will move from 

the Pool to the Holding GL. 

o Expire/Writeoff – either if the subsidy value expires or manual written off, the value will move 

into this GL account. 

 Description 

o This is a free text box, allowing users to specify a description. This field is optional and only 

visible internally. 

 Default Grant 

o This is the default value (monetary value) that will be displayed in Front of House when a staff 

member assigns the relevant subsidy account. 

 Max Grant 

o This is the max monetary value a staff member can assign to a contact/member. 



 Max Usage in Transaction 

o Users can configure a percentage value for this field. This means, what percentage value can a 

contact/member use from their subsidy value when paying for the relevant item in Front of 

House or online. 

 Applies To 

o Users configure which inventory can be paid for by a subsidy account. The inventory are group 

by the inventory main category. 

 

8.5. CONFIGURING THE TENDER TYPE 

 

The final part of the setup, is to configure a new tender type that will be used in Front of House when a 

contact/member uses their subsidy value. This tender type will only appear in Front of House if a 

contact/member has a subsidy value. 

 

Access Control Panel > Data > Inventory/POS > Configure Tenders > click on New 

 

The following fields needs to be specified once the Tender Type box appears: 

 

 Short Description 

o This is the name that will appear in Front of House. 

 Description 

o Can be the same as your Short Description or more detailed can be entered here. 

 Media 

o Leave blank 

 Active Date 

o Leave blank 

 Inactive Date 

o Leave Blank 

 Is Card 

o Leave all options blank 

 FOH Tender Type 

o Users must select the PrepaidAccount option. Note, once this type has been used, users cannot 

created another tender type using the PrepaidAccount again 

 



 
 

 

8.6. AVAILABLE SUBSIDY/STORED VALUE ACCOUNTS REPORTS 

 
There are a wide range of reports available for subsidy accounts. Reports are listed below and will be further 
explained during Reports training. 
 

 Prepaid Accounts 

 Prepaid Account Subtype 

 Prepaid Account Transaction 

 Prepaid Account Transaction Type 

 Prepaid Account Type 
 

9. SURCHARGING 

 
Legend allows customers to configure certain inventory items to have a surcharge associated when it is being 
sold in Front of House or online. The surcharge will be automatically applied based on the configuration. 
 

9.1. SECURITY TOKENS 

 
Before starting configuration, the following security tokens will be required. 
 



 Allow user to configure Vicinities (CP_VICINITIES_SHOW) 
 

9.2. CONFIGURATION EXPLAINED 

 
There are two areas to configure for Surcharging. 
 

9.2.1. VICINITIES 
 

Vicinities needs to be configured first. This is where users specifies which postal code areas falls outside the 

surcharge policy. For example: postal code area K1V 7T2, any contact/member within this postal code area will 

NOT have a surcharge applied to the items they purchase. 

  



9.2.2. SURCHARGES 
 

Within this area, relevant inventory items are tagged as being applicable for a surcharge. Currently users can 

configure set value or percentage to be applied. 

 

9.3. VICINITIES CONFIGURATION 

 

This area can be accessed via Control Panel > Data > Vicinities 

 

 
 

Within the configuration area, users can view and edit existing vicinities. From here, new ones can be added by 

selecting the New button. 

  



 

Provide your new vicinity with a name and description and click ok.  

 

 
 

Once created, double click on your vicinity, from here users will now specify which postal codes a surcharge 

should NOT be applied to by clicking on the Add option. Users can also remove postal codes by selecting the 

relevant postal code and clicking on the Remove option. 

  



Note: users do not have to specify the entire postal code. For example: postal code K1V 7T2 can be enter as K1V. 

 

 
  



9.4. SURCHARGES CONFIGURATION 

 

Access surcharges from Control Panel > Data > Surcharges 

 

 
 

The Surcharges Category/Location configuration box will appear. 

 

On the first tab (Categories) inventory items are grouped by the inventory main category. Users will either need 

to check the box against the main category (this means all inventory within that category will be selected) or 

expand each category and select the relevant inventory items that a surcharge will be applied against. 

 



 
 

Users will now have to navigate to the Locations tab within the Surcharges Category/Location window. Within 

this section, the relevant location is selected for the surcharge to be applied. Locations can either be Enterprise, 

Group (only clubs within that group will be affected) or a specific club. Once the relevant location has been 

selected, the last item to configure is the surcharge percentage/flat fee at the bottom right within this section. 

Once all fields have been set, click the Save option. 

Note: customers can set different rates at different levels. 



 

9.5. ENABLING SURCHARGES AND CONFIGURATION 

 

Users will now have to enable the Surcharge settings in Control Panel first; Control Panel > Global Settings > 

Enterprise Settings > Select Enable Surcharges > Set the desired rate > And select your configured Viccininty in 

the “Note in vicinity” drop down options. 

Options explained: 

 Enable Surcharges 

o This is to enable the setting. 

 Rate 

o This will the customer enterprise rate. Note, from point 9.4 above, customers can set different 

rates at different levels. 

 Not in vicinity 

o Choosing your vicinity configured in point 9.3 above. 

 

10.  LEGEND BOOKINGS 

 
The Legend Bookings module is used to configure a number of booking related items: 
 



 Physical Resources: Create the booking locations available at this club/site/facility such as Swimming 
Pool, Lane 1,2,3. These resources will be used system wide when scheduling activities, bookings, camps, 
events etc. 

 Instructors: Create class/course instructors. 

 Classes: Configure & schedule drop in classes. For courses/programs we recommend using the Legend 
Sports Courses application in back office. 

 AdHoc Bookings: Configure ‘Scheduled on demand’ types of bookings such as Squash, Badminton etc. 
  



10.1.  CONFIGURE RESOURCE SUB TYPES 

 

Subtypes are used to group resources together. There are 4 types of subtypes that can be configured. 
 
Add/Edit: Open Legend Bookings >> Manage >> Resources >> Resource Sub Types. 

10.1.1. ACTIVITY (PHYSICAL RESOURCES) 
 

 Best practice is to link all physical resources to a ‘Activity’ resource sub type, this will enable you to make 
multiple types of bookings in these locations. 

 
For example, if you have the following physical resources then you should setup like so... 
 
Physical Resources    Sub Type     
Sports Hall     >>  “Sports Hall Activities” 
Squash Courts     >>  “Squash Court Activities” 
Swimming Pool     >>  “Swimming Pool Activities” 
 
 

 
 

 If the physical resource will be used for drop in classes its best practice to create a series of “Booking 
Location” physical sub types. When attached to an activity they will allow the user to pick which location 
to use when scheduling a drop in activity.  

 

 
 

10.1.2. HUMAN (INSTRUCTORS) 



 

 Instructors can be linked to drop in classes or courses/programs. The sub type allows you to group the 
different types of instructor. For example, you might want to create “Swim Instructors” that you link to 
your pool based classes, or “Fitness Instructors” for fitness classes etc.. 
 

 
 

10.1.3. ACTIVITY (AD-HOC) 

 
All activities require their own sub type should you wish to enable online bookings.  
 

 Resource Type: Activity 

 Booking Type: Schedule On Demand 

 Support Online Booking: Enable 

 Is Active: Enable 

 Time Table Style: Activity 

 Sub Type Category: Configured in Legend Bookings >> Manage >> Sub Type Category. This is viewable 
online and used to separate different types of bookings. 

 Advance Limit: This is the number of days that a customer can book online for this activity, set this to 
the same value as the activity. It can be overridden per agreement. Set the same value for both fields. 

 Max Overall Online Bookings: Used to limit the amount of times any activity that is linked to this sub 
type can be booked per week. 

 Max Online Bookings (Per Member): Used to limit the amount of times a member can book any activity 
that is linked to this sub type. 

 Allow Court Selection: Enable this if you would like to allow customers to select their court/sector 
preference online. 

 



 

10.1.4. ACTIVITY (DROP IN CLASS) 

 

All activities require their own sub type should you wish to enable online bookings.  
 

 Activity (Drop In Class): Each class will require a subtype if you want to make it bookable online, this is 
essentially an online booking category. It can be the class name or class group. 

 Resource Type: Activity 

 Booking Type: Pre Scheduled 

 Support Online Booking: Enable 

 Is Active: Enable 

 Time Table Style: Standard 

 Sub Type Category: Classes – is the default setting. Other options are configured in Legend Bookings >> 
Manage >> Sub Type Category. This is viewable online and used to separate different types of classes.  

 Advance Limit: This is the number of days that a customer can book online for this activity, set this to 
the same value as the activity. It can be overridden per agreement. Set the same value for both fields. 

 
 



 
 
 

10.2. CONFIGURE RESOURCES 

 

 New: Open Legend Bookings >> Manage >> Resources >> Add Resource. 

 Edit: Use the drop down box at the top of the ‘Resource Details’ box to select another resource. 
o Alternatively, click on anything in the resources area >> then right click anywhere on the 

booking sheet >> Resource Details >> Use the drop down at the top to find the resource. 
 

 



10.2.1. GENERAL 

 

 Resource Name: Enter a name for this resource.  

 Resource Type: 
o Activity: Set for AdHoc activities and drop in classes. 
o Human: Set for instructors. 
o Physical: Set for physical resource locations. 

 Resource Group: Where this activity will appear in bookings folders, such as classes. If you need a new 
group, this can be created in Manage >> Resources >> Resource Groups 

o Physical: Set to ‘Booking Sheet’. 
o Human: Set to ‘Instructors’. 
o Activity (Class): Set to ‘Classes’. 
o Activity (AdHoc): Set to ‘System’ 

 Difficulty Level: Set to ‘Beginner’. This setting is not used. 

 Age Limit: Used for to limit the age of customers booking this activity. 

 Gender Restriction: Used to restrict the gender of customers booking this activity. 

 Max Capacity:  
o Activity (AdHoc): Set to 1. 
o Activity (Drop In Class): Set to any number greater than 1. 
o Human Resource (Instructor): Set to 1. 
o Physical Resource (Location): Set to 1. 

 First Time Setup: Not used. 

 Closedown Time: Not used. 

 Advanced limit: Set set how many days in advance the activity can be booked, it counts today as a day 
so a week in advance would be 8 days. This only affects activity resource types. 

 Is Active: Tick. 

 Is Bookable: Tick. 

 Allow Double Booking: Tick this if you want to allow multiple bookings of this resource. For example, if 
you have a generic “Swim Instructor” you might want to tick this to allow you to use this multiple times 
until you know who is actually instructing the activity. 

 Force Adjacent Bookings: Commonly used for ad-hoc bookings so that members have to book into 
specific slots instead of specifying exactly what time 

 Is Parent: This should only be ticked if it’s a physical resource that is being configured. For example, I 
would tick this on ‘Swimming Pool’ but not tick this setting for Lane 1, Lane 2 etc. 

 Parent Resource: Should only be selected if configuring a parent resource, this is used to link resource 
sectors (e.g lanes of a pool) to the parent resource (e.g swimming pool). 

 Club: Set the location for the resource. Resources are configured per club/site/facility. 

 Timeslot: This will enable you to book activities in Front of House with different time slots, for example 
you might want Squash to be bookable in 15min increments such as 9.00, 9.15, 9.30, 9.45 etc. It will also 
stop activities from overlapping on the booking sheet and will give you a cleaner view, it is important to 
set this on both the activity and physical resources (including parent resource). 

 Duration: Enter the duration of the activity. For human / physical set to 60. 

 FOH Timeslot Override:  

 Setup Time: Not used. 

 Max Future Bookings: Used to limit the number of future bookings members can make. Quite often 
members will get a 100% discount on activities which opens it up to abuse. This helps resolve that. 

 Advance Limit Apply Time: If an advance limit has been set, this option allows you to set the time at 
which the activity becomes available for bookings. 

 Disallow Double Booking (Member): Prevents customers from booking 2 activities at the same time. 
 



Drop In Class Example Setup  
Note the resource group and capacity 

 

 
 

AdHoc Activity Example Setup 
Note the capacity should always be set to 1 

 

 
 
 

 



Parent Physical Resource Example Setup 
Note ‘Is Parent’ is ticked and the capacity should always be set to 1 

 

 
 

Sector Physical Resource Example Setup 
Note ‘Parent Resource’ is set to the parent resource (swimming pool) 

The capacity should always be set to 1 
 

 
 

 



10.2.2. LINKAGE 

 

 Activity (AdHoc): Link to the parent physical (resource).  
 

 Activity (Drop In Class): Link to the sector physical (resource) that you want to book out when 
scheduling an instance of this class. If you created the ‘Booking Location Sub Types’ from the 
previous section, you can link to these here so that you have an option picking the booking 
location when scheduling an instance of this class (see below screenshot). 
 

 
 

 Human Resource (Instructor): Only the general tab should be completed for human resources. 
 

 Physical Resource (Location): Link to the activity subtype that corresponds to this location. For 
example, if this was a Swimming Pool or a lane in that pool, I would link to “Swimming Pool 
Activities (sub type)” on the parent and all of the sectors (lanes). 

 

  



10.2.3. AVAILABILITY  

 
Set the days and times that this resource is available, for pre-scheduled activities you can select all days / times. 
 

10.2.4. ADVANCE NOTICE 

 
Advance notice works like the advance limit described on the general tab. It is used to define how far in advance 
a customer can book an activity in FOH & online. Setting it here allows you to bulk update it should you ever 
need to change the limits. 
 
Setup: Legend Control Panel >> Data tab >> Bookings >> Setup Booking Notice Periods 
 

10.2.5. ONLINE 

 
Only use configure this for Activity resource types to enable online bookings. 
 

 Book Online: Tick to enable. 

 Advance Limit (Members): Set the number of days in advance a customer can book this activity. 

 Advance Limit Apply Time: Set the time at which the activity will become bookable online. 

 Web Description: Enter the text to appear online when a customer is browsing this activity. 
 

10.2.6. MISC 

 

 Inventory: Only select an inventory item for a activity resource type. Otherwise leave it set to <None>. 

 Is Default: Ticking this will automatically take you directly to this resource when the module is opened. 

 Cancellation Cut off – Days and Time: 
o Cancellation Cut off Day: Set the number days before the activity starts that you will still offer 

the customer a refund upon cancelling their booking. 
o Cancellation Cut off Time: Sets the time of day for the cut off. 

 Cancellation Cut off – Hours Before: 
o Cancellation Cut off Hours: Set the number of hours before the activity starts that you will still 

offer the customer a refund upon cancelling their booking. 

 Fixed Cancellation Fee: If a customer cancels their booking outside of the cut off hours, you can opt to 
charge a cancellation fee. 

 Late booking time period: Allows front desk / reception staff to book customers into a drop in class 
even though the class has started, set in minutes. 

 Force booking payment: Will not allow ‘Book & Pay Later’ if ticked. 

 Waiting List Type: By default, this is set to Inherit the setting configured in ‘Global Settings’, it can be 
overridden if required. 

 Waiting List Capacity: Set the maximum capacity for the waiting list. 

 No Of Mins Before for Last Waiting List Email: Set when the last email is sent to customers. 

 No Of Mins Before for Last Auto Waiting List: Set when the last email is sent to customers. 

 Enable booking auto set status: Configuring this will automatically update the booking status of 
customers enrolled into the activity. By default, the status is updated when the customer ‘swipes’ in via 
FOH to mark their attendance. 



10.2.7. SECTOR LINKAGE  

 
This tab is only used for Ad-Hoc activities. Sectors will only appear if you have linked the parent physical 
resource on the linkage tab.  
 

 Select the number of sectors that the activity uses in one booking. 

 Highlight the combinations of sectors to be used and move them into the linked sectors box. 
 
For example, if you have 4 fields and this activity uses 2 fields, you would configure it as per below: 
 

 

10.3. CREATE NEW RESOURCE GROUP 

 

 Manage >> Resources >> Resource Groups 
 

Here you can create new resource groups / folders which activities & instructors can be added to, we advise to 
have a group named “System” to hide away your ad-hoc booking activities and a group named “Instructors”. 
 

10.4. FIND A CANCELLED CLASS 

 

 Open Legend Bookings >> Tools >> Basic Search 
 

 
 

 Select the resource to search or expand the groups to narrow down the search results. 

 Select the start and end dates / times then select ‘Search’. 



 
 

 This will show all booked and cancelled classes / activities with the criteria you selected. You can double 
click on a resource to see more information about it or instead single click on a resource and press the 
Reactivate Schedule button towards the top right of this window. 

10.5. SYSTEM BOOKING 

 
A system booking blocks out a resource on the booking sheet to reserve the space or prevent any other 
bookings from using the resource.  
 

 Locate the resource to block out.  

 Right click anywhere on the booking sheet >> Select “System Booking”. 

 Edit the duration and set any recurrence options. 

 Click OK when complete to block out the resource. 
 

 
  



11. BOOKING SETTINGS 

11.1. MEMBER SWIPE AUTOMATICALLY ATTEND BOOKINGS 

 
This configuration gives the ability to set a number of minutes either before or after the cut off a class to mark 
the member as attended. This can be set at global, region and club level along with settings against the resource.  
 
In order to do this, firstly go into the Legend Control Panel >> Global Settings >> Bookings Tab there you will find 
the following settings, this can be found at the bottom right hand side of the box: 
 

 Enable booking auto set status – This enables the feature. 

 Cut off Time – Sets the number of minutes for the cut off. 

 Before or After activity – Sets if the number of minutes to cut off is before or after the start time. 

 Auto Status – Two options for the members status to be either Non-Attended or Cancelled. 
 
The second place this feature can be configured is against each resource, as a resource override. The can be 
accessed via Legend Bookings >> Resource Details >> Misc Tab.  

 

 
The following settings are available against a resource: 
 

 Enable booking auto set status: The default is set to inherit but can be turned on and off if required. 

 Cut off Time: Number of minutes for the cut off. 

 Before or After activity: Sets if the number of minutes to cut off comes before or after the start time. 

 Auto Status: Can either be set to Non-Attended or Cancelled, this is the status that a member will 
moved to.  



11.2. CLASS & LEGACY COURSES WAITING LISTS 

 
For instructions on configuring Camp or Sports Courses waiting lists please see the relevant documentation. This 
section is only for classes or courses that are configured directly in the Legend Booking module. 

11.2.1. WAITING LIST CONFIGURATION 

 

 Open Legend Control Panel >> Global Settings >> Bookings tab >> Waiting List Type 

 

Here you will have 4 global settings for waiting lists, these can be overridden per booking resource in the Legend 

Booking application >> Resource Details >> Misc tab. 

 

 Manual (Staff Only): Only staff can move members from the waiting list into the activity. 

 Auto Book First From List: Legend will automatically book the first member from the waiting list into the 

activity. 

 Contact All From List: Legend will send an email to all members on the waiting list whenever a space 

opens up for the activity, the first member to login and accept the space will take the space. 

 

11.2.2. DISABLE WAITING LISTS 

 
Disable: Open Legend Control Panel >> Global Settings >> Bookings Tab >> ‘Disable waiting list in Classes’ and 
‘Disable waiting list in Courses’.  
 

 
 
This setting, once ticked, will disable the use of Waiting list in Bookings across all clubs. The same settings also 
exist in the Club and Group sections on Legend Control Panel in the bookings tab. These can be set individually 
to disable or not or they can inherit the setting from the level above. 
 

11.3. ADVANCED BOOKING PENALTIES  

 
Booking penalties can be applied to members who don’t attend specific types of bookings, ultimately there are 2 
types of penalty, the first is to raise a charge for non-attendance and the second is to restrict the ability to book 
for a set amount of days. 



 
To enable booking penalties: Open Legend Control Panel >> Global Settings >> Booking Attendance tab >> 
Select “Booking Penalties Enabled”. 
Applies To: Select the types of bookings that this applies to. 
Attendance Ratio: These settings are used in conjunction with raising charged for non-attendance. Tick to raise 
charges on non-attendance and / or calculate the attendance ratio (see the below for further information). 
Advanced Booking Penalties: These settings are used in conjunction with restricting a members ability to book. 
Rolling Period: Strikes will accumulate throughout this period and reset after the number of days entered here. 
 

 
 
Next you need to go to Legend Control Panel > Data > Booking Attendance, choose whether you wish for the 
penalties to be applied at Enterprise / Region / Club level.  
 

 Add a description and short description 

 Tick to raise charges on non-attendance 

 Charge discount raises the discount that applies to the member on that particular agreement. This will 
show the following day 

 Charge flat fee charges a certain amount for each non attendance  
 
Alternatively, a more lenient way of raising penalties for example three strikes and a no admission ban will be 
imposed for a certain period of charge then go to Legend Control Panel > Global Settings > bookings tab. Tick 



enable advanced penalties, then specify the rolling period. Next go to Legend Control Panel > data > advanced 
booking penalties, you will need to do one rule at a time.  
Strike validity is the number of days admission will be prohibited 
You then need to apply to a certain group of activities. 
 

 
 
In order to lift a penalty, you need to go into Membership Management > Special > Adv. Booking Penalties. 
 
When you open advanced booking penalties it will show all the bookings for that person, on the right hand side 
you then depending on your security permissions perform the following functions: 
 

 Inactivate the strike 

 Change the ban  

 Lift the ban       
 

12.  BULK ADMINISTRATION TOOL 

 
The Legend Bulk Admin Tool has been modified to allow the bulk update of membership data such as cycle fees, 
agreements, charges and payments. This functionality will turn a time consuming task into an easy, efficient 
process.  Please be aware that you must have the appropriate access rights to use the bulk admin tool.  If you 
don’t have access, please contact your Super User. 



 

 
  
The first requirement for the Bulk Administration Tool is for the Bulk Administration Report to be run from the 
reporting application, filtering for the required members. The report is then saved as an excel ‘.xls’ file and 
imported into the Bulk Administration Tool; the data is then validated before continuing to update the member 
records.  
  
The member administration options are split into three categories, events, member charges and agreement 
changes. The changes are then validated and completed against each selected member.  
   
The functions:  
 
The following administration functions are available in each category;  
  
Events  
  
•  Bulk raise events against a member record  
  
Member Charges  
  
•  Fixed Charge: User selects a charge and GL code to be raised against member record, including the option to 
raise and pay off the charge.  
•  Charge from sheet: User enters a charge against the relevant member in the import spread sheet. The charge 
goes into the column “Charge”. A GL code must also be selected.  
•  Contractual Balance: Will raise the member cycle fee multiplied by the months left on the contract.  
•  Create Credit Note: Creates a credit note of a user inserted value against the member.  
•  Clear Balance: Will clear any outstanding balance against a member and set it to zero.  
•  Clear Credit Notes: Will set the remaining balance of a credit note to zero.  
  



Agreement Changes  
  
•  Reactivate Members: The selected members will be reactivated as if each member has been through the 
wizard.  
•  Lapse Members: The selected members will be lapsed as if they have been through he wizard. A termination 
reason must also be given.  
•  Change Dates: The application will take the dates entered into “NewObligationDate”, “NewRenewalDate” and 
“NewLastUseDate” columns of the import spreadsheet and set them against the member’s record.  
•  Change Cycle Fee: The cycle fee will be changed to the value found in “NewCycleFee” column of the import 
spreadsheet.  
•  Upgrade Agreement: The member will be upgraded as if going through the wizard to the agreement and price 
type set in the import spreadsheet columns “NewAgreement” and “NewAgreementPrice”.  
•  Change Next Bill Date – The members next bill date will be moved to the date value set in the 
“NewNextBillDate” column of the import spreadsheet.  
•  Change BACS code: The BACS code selected in the dropdown will replace the members current BACS code.  
•  Enable Collect-All: This will enable the collect all tick box against the member record.  
•  Disable Collect-All: This will disable the collect all tick box against the member record.  
   
Bulk Administration Report  
  
The Bulk Administration Template report can be found in the directory Memberships > Member List Report > 
Member Status > Bulk Admin Template. The report has no customizable columns and must stay in the same 
format and column order otherwise the eventual import will fail.  
  
The report can filter on the following;  
Organisation – Club, Region or Enterprise  
Range – Membership Type, Member Status and Post code  
Selection – Name, Billing Method, Gender, Age, Agreement type, Marketing Source,  
Member start date, Joined date, Obligation date, Renewal date, Termination date and Contracted agreement.  
  
Once the report has run and been filtered to attain the correct pool of members it needs to be converted into an 
excel document and then saved as a .xls file which will be ready for importing into the Bulk Administration Tool.  
  
Import   
  
Once the report is ready and saved open the Bulk Administration tool from the desktop. Use the menu shown in 
Fig 1.2 to browse to the .xls file to import.  
 

 
 
Once the file has been selected the import button will become available to use. Clicking  this button will import 
each member row on the spreadsheet into the Bulk Administration tool ready for validation, depending on the 
amount of members importing it could take a few minutes. The status bar at the bottom of the application will 
show the progress of the import.  
  
Once the import has finished the members will show in the application but they will be red, this means that the 
members have not yet been validated. The validation button will now be available on the menu, clicking this 
button will run a validation check against each member, members that turn black are valid and members that 
stay red are not valid and any administration carried out against them will fail. The validation run against the 
member checks that the member number in the spreadsheet matches a member number in the Legend Core 



Applications. Fig 1.3 below shows three members that have had the validation run against them, with one 
member failing the validation.  
 

 
  
A tick will appear, in the far left column, against all valid members. This tick represents the members that will 
have the administration task completed against them. There are two buttons on the menu that selects/de-
selects all members and the clear list button will remove all members that have been imported. If another 
import is completed whilst the data is still in the tool, the original data will be overridden, the application will 
warn the user before overwriting any data.  
  
Once the required members have been selected the tool is set up to move onto the administration functionality. 
As previously stated the three areas of administration are events, member charges and agreement changes.  The 
three sections below outline how to use each area;  
  
Events  
  
The first requirement after clicking on the events tab is to enable the functionality by ticking the Enabled box at 
the top left hand corner, as shown below. 
 

 
  
Once this box has been ticked all the options will become available to use. The first selection is the event 
category, depending on which event category is chosen the event type will be filter in the next drop down box. 
For example, selecting the event category of BACS will filter the event types to just the BACS events.  
  
The Event Date field allows a date to be set against an event; this date is when the event will become active. The 
comments box is a free text field and is required when adding any events. Once the event has been selected and 
a comment been entered clicking the “Add Event” button will add the information to the screen, as shown 
below 
 



 
  
At this stage you can add more events to the list by repeating the same process again. The tick box next to each 
event row will disable/enable the event.   
  
Once all events have been added to the list, the next step is to complete the process. Clicking on the complete 
tab will show an audit box, reason and a validate/process button, as shown below. 
  

  
  
 
Entering a note in the reason field at this point will add a user entered note when the event is raised against a 
member. To complete the process click validate, which will run the validation again to make sure nothing has 
changed and then click process. At this point the application will remind the user that this can’t be undone and 
would you like to proceed.   
  
A pop up message will show if the administration is successful. Any members that the administration was not 
completed against will show in the audit list.  
  
Member Charges  
  
As with the events the member charges section needs to be enabled by ticking the box in the top left hand 
corner.  



 
  
The member charges section is split into two sections and only one section can be enabled at a time. The 
member charges section is shown above. 
  
A charge or other fiscal charges are selected by highlighting the bullet point next to the item. Some of the fields 
here require extra information such as a GL code, amount, whether to pay off the charge or not and the GL code 
payment.  
  
The charge from spreadsheet option will raise the relevant charge that is listed in the column “Charge”.  
  
Once the relevant item has been selected proceed to the complete tab, enter a note and validate then process. 
A pop message will confirm the completion of the administration task and any members that an issue occurred 
against will show in the audit log.  
  
Agreement Changes  
  
The agreement changes section is also split into two parts, Agreement changes and BACS. These are enabled in 
the same way as the other sections, shown below 
 

 



 
  
Selecting an agreement or BACS change works the same way as the Member charges section, by highlighting the 
bullet point next the item. The lapse member option requires a termination reason and the change BACS code 
also requires the new BACS code.   
  
Once the relevant option has been selected and any extra information been supplied navigate to the Complete 
tab.  
  
Follow the same process as the previous steps, enter a note, validate and then process. The pop message will 
verify the administration task is complete and any members with issues will show in the audit log.  

13.  USER MANAGEMENT 

 
User management is where you can edit club access and permissions within Legend for any Legend user.  
You can access this by opening the Legend Control Panel > User Management > Select a user. 

13.1. GENERAL 

 

 Username and password is set by Legend support, changing your password here will not change your 
Legend login password. For any changes or new users please contact Legend support. 

 Member record – Each staff member in Legend has a STAFF membership within Membership 
Management, it is advised not to change this member number.  

 This user has enterprise access – If you want to be able to edit enterprise wide inventory items / reports 
/ clubs then this needs selecting. Generally, all super users would have this ticked. 

 Other options should not be ticked. 
 

13.2. OTHER TABS 

 

 Contact details do not need adding for any users, if you wish to add an address, this would be done via 
Membership Management. 

 Clubs – Select which clubs the user has access to. 

 Club Groups – Select the club groups that the user has access to. 

 User Groups – This is where the Legend security permissions are assigned to a user, it is advised to only 
select one group per user. 

 Combined Tokens – This section shows all of the security tokens that the user has assigned to them. 

 Audit – Will show you any changes that are made to the user. 

14.  SECURITY MANAGEMENT 

 
This section is used to set up or edit the various levels of permissions that will be assigned to users within 
Legend.  
To add a new group you will need to open Legend Control Panel > New tab > Select “New User Group” and then 
to edit this group open Security Management in the Legend Control Panel. 

 Permissions: This is where you select the individual security tokens that you want to assign to this 
group. 

 Users: Current users assigned to this group. 

 Audit: There is an audit log of all changed made to this group. 



15. DOCUMENT MANAGEMENT 

 
From the Legend desktop open up “Computer” and browse to the “I:/ drive”, open an existing document and 
resave it as something new (File > Save As).  Once the letter has been written the process to add the merge 
fields is now required. 
 
In word 2010 select the insert tab, quick parts, field, merge field and then insert the field name (this needs to 
match the field names that are run by Legend, the list will be saved in the customers I drive).   
 
Add the fields required and then save the document.  Make sure this is saved a Word 97-2003 Doc. 
 
Select document management in the Legend Control Panel and then select new and fill in the relevant 
information as below.  Make sure that the mail merge field box is ticked. 
 

 
 
If the marketing document box is ticked then members that have requested not to receive sales communication 
then the system will not allow a letter to be generated for them. 
 
To complete the mail merge there is a 3 options. 
 
Open Membership Management, expand the Comms and select Document. 



 
 
Search for the template that has been created previously.  Using this option it will only search for the current 
member in the membership database.  At this point the option is to either view or print the document. 
 
The second option is to use the search engine at the top of the page. Conduct a search then use the merge 
button on the right hand side of the screen 
 

 
 
 
Load up the reports application.  Choose any report (good example – active member).   Use the merge button on 
the left hand side of the screen.  Select the letter and follow the instructions. 
 


